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Lab 6: Fluids and Drag
I. Before you come to lab...
II. Background
III. Introduction
A. In this lab, you'll explore the physics of fluids, both through static properties such as pressure and buoyancy, and
phenomena related to fluid flow, such as viscosity and drag. You'll measure your own blood pressure in several different
configurations and think about why they are different. You'll also explore drag forces on a falling sphere in a viscous liquid
and use the concept of terminal velocity to characterize the fluid's viscosity and density. Finally, you'll learn about Reynolds
numbers and how they can be used to characterize fluid flows.
B. Objectives for this lab:
1. Understand and measure terminal velocity
2. Verify the Stokes formula for viscous drag force
3. Experimentally determine the density and viscosity of a fluid
4. Estimate Reynolds numbers and understand what they mean
5. Learn how to use Reynolds numbers for design and modeling
6. Measure your blood pressure at several different places and configurations
IV. Materials
A. Digital video camera
B. 600 mL beaker filled with yummy karo syrup
C. Forceps
D. Box containing spheres of different materials, all with 1/16" radius
E. Blood pressure sensor
1. The blood pressure sensor consists of an inflatable cuff which connects to a pressure sensor.

2. The pressure sensor is a small box that connects to the computer and is interfaced using the Logger Pro software.
3. Blood pressure is typically measured with two numbers: the systolic and diastolic pressures. This is because your
blood is not a static fluid: the pressure in it varies during each pulse beat as blood is pumped through the body. Both
systolic and diastolic pressure are reported in units of mmHg (millimeters of mercury). So a blood pressure of "120 over
80" means a systolic pressure of 120 mmHg and a diastolic pressure of 80 mmHg.
a. The systolic pressure is the maximum pressure during a pulse, which occurs near the beginning of a cardiac cycle.
b. The diastolic pressure is the minimum pressure during a pulse, which occurs during the resting phase of a cycle.
4. The blood pressure sensor works by inflating the cuff to a high enough pressure to actually cut off blood flow in your
brachial artery (inside your arm). The cuff gradually deflates by leaking air; as it does so, blood flow resumes in your
artery at first spasmodically (as the pressure drops below the systolic pressure) and then more continuously (as it drops
below diastolic pressure). By monitoring the pressure inside the cuff, Logger Pro can detect the small pulses in the
declining pressure and determine what the systolic and diastolic pressures are.
5. The cuff is inflated by pumping on the bulb end of the tube. Next to the bulb is a valve; pressing this valve releases the
air from the cuff. The valve also contains a screw which can be turned to fine-tune the rate at which air leaks from the
cuff. Turning the screw clockwise increases the leak rate; turning it counterclockwise decreases the leak rate.
6. There is also a full instruction manual accompanying each blood pressure sensor. You can refer to it for more
information about the instrument.
V. Procedure
A. Before you begin...
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1. Take a picture of yourselves using Photo Booth and drag it into the space below:

V. Procedure
A. Before you begin...
1. Take a picture of yourselves using Photo Booth and drag it into the space below:

2. Tell us your names:
B. Blood pressure
In this part, you will each measure your own blood pressure at your upper arm using the blood pressure sensor, and think
a little bit about how the sensor works. In addition, one member of your group can volunteer to measure the blood
pressure at your leg while standing and while lying down. The results of this part of the lab will be used in the homework
assignment next week.
1. Measuring your blood pressure (arm)
a. Start Logger Pro (without opening a particular file). After a few seconds, it should detect the blood pressure sensor
and open a page with custom blood pressure readings.
b. Have the "patient" sit upright in a chair and, if possible, remove outer layers of clothing and roll up the sleeve as far
as possible. (If the sleeve is too tight to roll up, it is also fine to place the cuff over one thin layer of clothing.) Wrap the
inflatable cuff around the patient's upper arm so that the prickly velcro surface (and the label "INDEX ➡") face
outward. Also, turn the cuff so that the two rubber hoses are on the inside of the patient's arm by the bicep. The
bottom of the cuff should be about 2 cm above the elbow joint.
c. Important safety warning: Before you begin, make sure that you know how to release the pressure in the cuff (by
pressing on the valve). If the pressure in the cuff gets high enough to be painful to the patient, release it
immediately. For most people, it will not be painful to reach a pressure of 170 or 180 (though it is mildly
uncomfortable; after all, the idea is to cut off blood flow to their arm temporarily).
d.
When the patient is ready, click on the

button in Logger Pro to begin data collection. The patient must

keep her arm and upper body completely still throughout the measurement. Rapidly inflate the cuff (using full
pumps rather than small quick pumps) until the pressure reaches 160 and then wait. You will see the pressure slowly
decrease in the upper graph; the patient will feel (and maybe even hear) the pulses in her arm. After about 40
seconds, the oscillatory "peaks" will appear in the lower graph. These peaks are used by the software to calculate
systolic and diastolic pressures.
e. Eventually the lower graph will stop updating itself; at this point the data collection is complete. You can read off the
systolic and diastolic pressures from the meters on the screen.
f. If there is no reading after 120 seconds, or a clearly meaningless result (e.g. systolic less than diastolic), you can try
again. One common problem is that the cuff pressure should leak at a rate between 2 and 4 mmHg per second. If it is
leaking too slow or too fast, you might not get a reading. You can adjust the leak rate using the screw on the release
valve.
g. Once you have a reading, go to the File menu and select "Save As..." Name the file with your own name and save it.
Then locate the file in the Finder and drag it into this Notebook document below:
(1) Name:
Logger Pro file:
(2) Name:
Logger Pro file:
(3) Name:
Logger Pro file:
h. Repeat the process for all members of your lab group and attach the Logger Pro files above.
2. Measuring your blood pressure at the leg (optional)
If you would like to also measure your blood pressure at your leg, you may do so. It might be more uncomfortable than
measuring at the arm, because higher pressures are required to cut off the arterial flow in your leg. If nobody in your
group wants to do it, you can just use sample data when you get around to doing next week's homework.
a. Open the patient's Logger Pro file. You should see the data from their arm measurement there. Press Apple-L to
store that data.
b. Go to the Data menu and select "Data Set Options ! Run 1." Rename Run 1 to "Arm."
c. Now have the patient stand and roll up their pant
2-2 leg to the knee if possible. Wrap the cuff around the patient's lower
leg, around the thickest part of the calf. The rubber hoses should come out of the cuff in the back of the leg, not in
front where the shin is.

c. Now have the patient stand and roll up their pant leg to the knee if possible. Wrap the cuff around the patient's lower
leg, around the thickest part of the calf. The rubber hoses should come out of the cuff in the back of the leg, not in
front where the shin is.
d. You may find that because the pressure at the leg is higher, you need to increase the leak rate from the cuff.
Otherwise you might not get down to diastolic before the 120 s of data collection are over. The patient must remain
standing without moving their leg during the process.
e. Click on the y-axis of the upper graph and set the scale so that it goes from 0 up to 300 mmHg.
f.
Click on

and rapidly inflate the cuff to about 270, then wait.

g. When it is finished, press on the release valve to deflate the cuff and give the patient a chance for blood flow to return
to their ankle and foot.
h. Press Apple-L again to store the data run. From the Data menu, select "Data Set Options ! Run 1." Rename Run 1
to "Leg Standing."
i. When the patient's leg is back to feeling normal, have the patient lie down (on three consecutive chairs, or on the
ground, whichever feels more comfortable) and repeat the measurement again. This time, you need only inflate to
about 200 at the start.
j. Store the data run and rename it to "Leg Lying."
k. When you have completed all 3 measurements, go to page 2 of the Logger Pro file and you will see a summary of the
results. Paste a screenshot of that summary here:

l. Save the Logger Pro file and attach it again below:
C. Viscous drag
In this part of the lab, you will drop small spheres into a viscous fluid (karo syrup, which will be familiar to all of you from the
previous lab) and use the terminal velocity to determine the viscous drag on each sphere.
1. Open the file Lab6.cmbl in Logger Pro. Logger Pro should prompt you on whether you want to set up sensors. Click the
button for Use File As Is.
2. Set up the file to take video captures:
a. Go to the Insert menu in Logger Pro and select "Video Capture..."
b. Select "DV Video." If DV Video is not an option, it is probably because Photo Booth is using the digital video camera.
Quit Photo Booth and try again.
c. Select the default values for the resolution and the sound source.
d. Click the Options button in the Video Capture window and set the following options:
(1) Video Capture Only
(2) Capture Duration: 20 seconds
(3) Capture File Name Starts With: Teflon
(4) Click OK.
3. Position the camera so that you can see the beaker of karo syrup. Make sure that the yellow post-it note on the beaker
is visible; you will use it to set the scale of your video. Because the teflon sphere is white, use the dark background
behind the beaker to provide contrast so that the sphere will be easily visible in the video.
4. On the digital video camera itself, press the FUNC button to exit screensaver mode.
5. Using a pair of forceps, pick the white teflon sphere out of your box of different spheres and hold it in the karo syrup
about an inch below the surface. Release the sphere and then remove the forceps from the fluid.
6. Click Start Capture. Wait for 20 seconds, and the captured video will appear. Close the Video Capture window.
7. Analyze the video:
a. By now, you've done video analysis in Logger Pro several times. Here is just a brief reminder of the controls:
b. Start by setting the scale. The yellow post-it note on the beaker is exactly 2 inches (5.1 cm) tall. You can use
whatever units you like, but your calculations at the end will probably be simpler if you have everything in SI units.
c. Track the motion of the ball as it slowly falls toward the bottom of the beaker. Several important points:
(1) You do not have to click the position of the ball in every single frame! (That would drive everybody crazy,
because the teflon ball falls so slowly.) After you've made one click, advance several frames by dragging the
progress bar at the bottom of the movie window until the sphere has moved a few diameters away, and then click
again. Ultimately, you only need about 5 to 7 points total to get a very good measurement of the velocity if they
are well spaced out.
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(2) However, don't track the ball when it has just been released, or the forceps are still in the fluid (moving the
forceps can disturb the motion of the ball even many diameters away), or if it is anywhere near the walls or floor

are well spaced out.
(2) However, don't track the ball when it has just been released, or the forceps are still in the fluid (moving the
forceps can disturb the motion of the ball even many diameters away), or if it is anywhere near the walls or floor
of the beaker. Any of these things could influence the ball's motion in an unpredictable way.
(3) Look at your graph as it appears. if it looks like the point at the beginning or the end isn't in line with the other
points, then just exclude it from your fit region when you do a linear fit on the graph to find the slope.
d. After you have plotted the points, go to the Data menu and select "Data Set Options ! Video Analysis." Change the
name of this data set to "Teflon."
e.
Click on the y-axis of the graph and select "Y" (this will get rid of the useless X values). Then do a

to find

the slope of the line. This will give you the terminal velocity of the falling sphere. Double-click on the fit box and check
the option for "Show Uncertainty." This gives (an estimate of) the uncertainty in the terminal velocity.
f. Paste a copy of your graph, with best-fit line, here:

g. Compare this graph to the one from the first pre-lab question. Is there a time when the sphere is accelerating?
h. Record the values for the terminal velocity, as well as its uncertainty, in the data table on page 5 of the Logger Pro
file.
i. Save the Logger Pro file (Apple-S).
8. Using the forceps, pick the teflon sphere out of the beaker. Try to wipe off as much of the syrup as you can using a
paper towel, and then put the ball back in its correctly marked compartment of the box.
9. Go back to page 2 of the Logger Pro file and repeat the procedure (steps 2 through 8) for the next ball, which is made of
titanium, and then likewise for the steel ball and the tungsten carbide ball. Each sphere has its own page in the Logger
Pro file for you to use. There are several key differences to note each time:
a. The other balls are all dark-colored, so you will be better off using the white background as a backdrop for the
beaker in the video.
b. When setting the Video Analysis Options, change "Capture File Name Starts With" to the name of the material for
each sphere that you drop.
c. Likewise, when setting the Data Set Options after you do each analysis, change the data set name to the name of the
material. That makes it much easier to keep track of which data set corresponds to which sphere. If you forget to do
this, the data sets will all be named things like "Video Analysis 2" and "Video Analysis 3" and you might not remember
which corresponds to which sphere.
d. By the time you get to steel and certainly tungsten carbide, you'll notice that the spheres fall much faster than the
teflon did. You may not need to use the whole 20 seconds of the video, and in addition, you'll probably want to start
the video capture before actually releasing the sphere with the forceps.
e. You don't have to paste the graph and answer questions about it for each ball. Just record the terminal velocity and
its uncertainty in the data table on page 5 for each sphere that you drop.
10. Analysis of the data
a. Graphical analysis
(1) Now go to page 5 of the Logger Pro file. You should see a data table populated with the density of each material
(which was determined for you), as well as terminal velocities (along with uncertainties) of each sphere. Create a
graph which plots density of the sphere (on the y-axis) against the terminal velocity (on the x-axis). Paste a copy
of it here:

(2) In the pre-lab, you thought about what the graph would look like if the drag force obeyed the Stokes formula
(proportional to v), and what it would look like if the drag force were instead proportional to v2. Which does it
resemble? Does the shape of your graph support the Stokes equation?
(3) Fit a line to your data and determine the following parameters (don't forget units):
(a) Best-fit slope =
(b) Uncertainty of slope =
(c) Best-fit intercept =
(d) Uncertainty of intercept =
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(b) Uncertainty of slope =
(c) Best-fit intercept =
(d) Uncertainty of intercept =
b. Density of karo syrup
(1) From your data, what is the density of karo syrup, with units?
(2) Is this a reasonable number compared with other known densities? (The density of air is about 1 kg/m3, water is
about 1000 kg/m3, and the densities of the four materials you dropped into the karo syrup are listed in the data
table.)
(3) By pouring karo syrup into a graduated cylinder on a precise balance, we directly measured its density to be 1.36
± 0.01 grams per mL. Does your measurement agree with this value? (You may have to do some error
propagation to fully answer this question.)
c. Viscosity of karo syrup
(1) Using your data, calculate the viscosity of karo syrup (with units). You may need to use g=9.8 m/s2, and the fact
that the radius of the spheres is 0.159 cm.
(2) What is the uncertainty in this viscosity? You may assume negligible uncertainty in g, but the radius does have an
uncertainty. In particular, the manufacturer reports that the diameter of the spheres is 125 ± 2 mils (1 mil is a
thousandth of an inch).
(3) Is your viscosity a reasonable number compared with other known viscosities? (As a reminder from the pre-lab
applet on viscosity, water has a viscosity of about 10-3 Pa·s, canola oil is about 10-1 Pa·s, motor oil is 1 Pa·s,
honey is 10 Pa·s, and various types of lava have viscosities of 102 Pa·s and up.)
(4) Suppose you had measured the terminal velocity of only one sphere (of known mass and radius). What
information would you need to know about the fluid in order to calculate its viscosity?
d. Go to the blackboard and write down your calculated density and viscosity with uncertainties.
e. Nylon has a density of 1060 kg/m3. From your linear fit, predict the terminal velocity of a nylon sphere of the same
size (1/8" diameter) submerged in karo syrup.
What does this result mean?
f. Reynolds number
(1) We would like to use these spheres in karo syrup model the behavior of bacteria swimming in water. The key to a
useful model is that the two systems have the same Reynolds number. First, estimate the Reynolds number of a
bacterium which is 1 !m long and swims (in water) at a speed of 10 !m per second.
(2) Now calculate the Reynolds number for each of the four spheres in karo syrup. There is a calculated column
called "Re" which is there for you to use on page 5 of the Logger Pro file; just double-click the column heading
and edit the field labeled "Equation" with the correct expression for the Reynolds number. (Remember, the " in
the equation for Reynolds number is the density of the fluid, not the sphere.) For the length scale, you can use
the diameter of the ball (0.32 cm). When you are done, paste a screenshot of your data table below:

(3) The Stokes equation for viscous drag is the appropriate one to use if the Reynolds number is much less than 1
(remember, Re indicates the relative importance of inertia compared with viscosity). From your data, were we
justified in using the Stokes equation in the analysis of the graph?
(4) The smallest Reynolds number of the spheres that you calculated is still quite a bit larger than that of a bacterium
in water—despite the fact that water is much less viscous than karo syrup. However, you have in your box a
sphere made of a synthetic plastic called torlon, which has a density of 1450 kg/m3. Using your linear fit, predict
the terminal velocity of the torlon sphere in
karo syrup, and then calculate its Reynolds number.
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terminal velocity =
Reynolds number =

sphere made of a synthetic plastic called torlon, which has a density of 1450 kg/m3. Using your linear fit, predict
the terminal velocity of the torlon sphere in karo syrup, and then calculate its Reynolds number.
terminal velocity =
Reynolds number =
(5) Try putting the torlon sphere into the karo syrup. (It's a little hard to see, because it is almost the same color as
the syrup.) What happens when you release it? (You don't need to do a video analysis of it.)
VI. Conclusion
A. When you have finished, cover your beaker of karo syrup with plastic wrap. Take your forceps and anything else that may
have been splattered with syrup and wash them off at the sink in the back of the room.
B. Submit your lab report online according to the instructions on the plastic sheet at your computer. Remember, when you get
to the step where you export to HTML, choose "Current Page" instead of "All," and leave the box for cover page
unchecked.
C. Super-duper important—don't even think about skipping this step! Before you leave the lab, every member of your
lab group should open a browser and go to
http://physci.fas.harvard.edu/~yourFASusername
and make sure that your lab report is there under the link called "Lab 6." If not, then you haven't submitted it correctly; ask
a TF for help. If your lab report isn't submitted, you won't get credit for doing the lab.
D. Don't forget to take all of your belongings with you when you leave the lab.
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